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Before the Workshop 

Please install QGIS and relevant plugins, listed below, prior to the workshop. 

 

Installing QGIS 

Prior to the workshop, please download and install QGIS, version 2.0 or higher (the current 

version at the time of writing is 2.4). Use the 32 bit version; the 64 bit version might be useful 

for large datasets and such, although some features and plugins may not be available for it yet.  

[Everything presented herein was tested using QGIS 2.2 or 2.4, 32 bit, on Windows 7 64 bit]. 

 

Note: The installation files can be somewhat large (~300mb for 32 bit Windows version) and 

might take some time to download and install. 

 

For Windows users: 

Download and run standalone installer, available here: 

http://qgis.org/en/site/forusers/download.html (QGIS Standalone Installer Version 2.4 (32 bit))  

When it gives you the option, you do not need to download the sample datasets, although feel 

free to and use them for other tutorials or examples. 

 

For Mac OS users: 

OS 10.7 and Higher: Follow the installation instructions provided here: 

http://www.kyngchaos.com/software/qgis 

http://qgis.org/en/site/forusers/download.html
http://www.kyngchaos.com/software/qgis
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OS 10.6.8: Try using the latest experimental build for Mac OS 10.6.8 provided here: 

http://qgis.dakotacarto.com/ (scroll down to and click on “Nightly for Snow Leopard - Mac OS 

X 10.6”). 

Alternatively, try compiling with HomeBrew (http://brew.sh/), following instructions here: 

https://github.com/OSGeo/homebrew-osgeo4mac. Please contact me if you have problems with 

these options and I will do my best to help. 

 

For Linux Users:  

Follow instructions provided here: http://qgis.org/en/site/forusers/alldownloads.html#linux.  

 

Installing QGIS Plugins 

QGIS is a powerful program, and part of its strength is the variety of free plugins that have been 

written for it. 

 To see what plugins are installed, open QGIS by double-clicking on the “QGIS Desktop” 

icon on your desktop or in your start menu.  

 Then, click the Plugins menu at the top of the main QGIS window, and navigate to 

“Manage and Install Plugins”.  

 When the Plugins window opens, search for the following plugins and install them if they 

are not indicated as already installed (having an X to the left of the name):  

o OpenLayers Plugin (may not be available for QGIS 2.4; that is alright). 

o Table Manager 

o Zonal Statistics Plugin 

o Processing 

http://qgis.dakotacarto.com/
http://brew.sh/
https://github.com/OSGeo/homebrew-osgeo4mac
http://qgis.org/en/site/forusers/alldownloads.html#linux
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Opening Notes 

Open-source tools for research in ecology and evolutionary biology, among other fields, 

are constantly expanding. Herein, I provide a tutorial of QGIS (www.qgis.org), which is capable 

of almost any GIS operation I’ve ever needed, either on its own, or using the various plugins and 

associated tools. QGIS installs and directly links with other programs including SAGA GIS and 

GRASS GIS, allowing users to take advantage of cooperation among the free and open source 

software developers. Furthermore, data can be exported to a variety of formats, for use in other 

software. For example, I typically process a great deal of spatial data imagery using QGIS, but 

later export it to use in R (http://cran.us.r-project.org/) for more statistical analyses. 

My goal here is to provide a basic skill-set to the new QGIS user, so they may feel 

comfortable navigating the program to carry out their own work, and so they can further explore 

its capabilities. This tutorial is by no-means comprehensive. I suggest users browse and search 

the QGIS documentation (http://qgis.org/en/docs/index.html) when they are stuck, or make use 

of relevant support channels (http://qgis.org/en/site/forusers/support.html). 

Some brief acknowledgements: I am grateful to the QGIS community for constant 

development and support of the software. I also thank Dr. Michelle Lawing in the Department of 

Ecosystem Science and Management at Texas A&M University (TAMU) for getting me 

involved in, and organizing the workshop for which this material was developed. This work was 

supported by the Ecology and Evolutionary Biology Interdisciplinary Program at TAMU, and 

Dr. Toby Hibbitts, curator reptiles and amphibians at the of the Biodiversity Research and 

Teaching Collections at TAMU for provided data for specimens, used herein as a text-delimited 

data source. 

http://www.qgis.org/
http://cran.us.r-project.org/
http://qgis.org/en/docs/index.html
http://qgis.org/en/site/forusers/support.html
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Data Sources Used 

The data sources used in this tutorial should be available for download in a single .zip folder, at 

the same URL where you accessed this document. Individual data layers and original sources are 

listed below. Please see the URLs for the original sources or the included metadata for individual 

layers for more detail. Throughout the document, I primarily refer to layers with the italicized 

names given below. 

 

Text Delimited Table 

Copperhead Data  – “Brazos County A contortrix_TxCentral.csv” – Specimen locations for 

copperheads, Agkistrodon contortrix, in Brazos County, Texas, provided by the Biodiversity 

Research and Teaching Collections at Texas A&M University (http://brtc.tamu.edu/). Most 

localities were collected in the WGS84 datum; the others are assumed to be, for this tutorial. 

 

Vector Data (Shapefiles) 

The following layers for Brazos County and the city of College Station, TX were accessed from 

the City of College Station GIS Department (http://www.cstx.gov/index.aspx?page=3683). 

1) County Boundary – Brazos_County_Boundary_8-20-02.shp (in /Brazos Limit Package”) 

2) City Limits – City_Limits.shp (in /City_Limit_Package) 

3) Rivers and Streams – Rivers_and_Streams.shp (in: /Rivers and Streams Package”) 

 

http://brtc.tamu.edu/
http://www.cstx.gov/index.aspx?page=3683
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Raster Data 

The raster dataset used in this tutorial is the 1 Arc-second (~30m) Digital Elevation Model from 

the U.S. Geological Survey 

DEM – imgn31w097_1.img (in /DEM 1ArcSec)  
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Get to Know QGIS 

Open QGIS on your computer using the QGIS Desktop icon in your Start Menu or Desktop. 

 Close the tip of the day – you can permanently disable or scroll through them. 

 Only one pane is open – the “Layers” pane on the left side 

 Explore icons by hovering over them with the mouse; click on menu-bar items to explore 

the drop-down menus. 

To save the project click the “Save” icon and designate a file location. When you re-open a 

project, any layers that you were using should be in the same locations on your computer; if they 

are not, you will need to re-designate the appropriate file paths. If you transfer data and a project 

file to another computer, keep the files in the same locations relative to one another and the 

project should open without a problem. Make sure to periodically save the project as you work. 

 

Open Shapefiles 

 Click the “Add Vector Layer” icon (Or use “Layer” menu and navigate to  “Add Vector 

Layer”) 

o Set the Source Type to “File” and Encoding to “System” 

o Click “Browse” and navigate to the appropriate files, using the appropriate file 

types (for Shapefiles, set to “ESRI Shapefiles [OGR] (*.shp)”). 

o Open County Boundary, City Limits, and Rivers and Stream layers. 

**Note –To access data from ESRI Geodatabase (.gdb files), set “Source Type” to 

“Directory”, and navigate to the .gdb file. 

 Adjust the layer order by clicking and dragging layers up and down in the “Layers” pane. 

o Put Rivers and Streams on top, then City Limits, and County Boundary 
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 To adjust layer symbology (how the data appear): 

o Right click on individual layers and select “Properties” (or Double Click on the 

layer) 

o Select “Style” on the left; click on a symbol in the “Symbol Layers” box, and 

customize to your liking. 

 To view the tabular data, right click on the layer and select “Open Attribute Table”. 

 To view information about a layer at a specific point in space, click on the “Identify 

Features” icon on the tool bar, and click on the point of interest. The default setting show 

information about the layer highlighted in the “Layers” pane. 

 

Open Delimited Text Layer (e.g., points based on a table with Coordinates) 

 Click “Add Delimited Text Layer” icon. (See example dialogue box on next page.) 

o Navigate to the appropriate file (Copperhead Data; “Brazos County_A 

contortrix.csv”) and set appropriate text delimiter (comma for this file). 

o If the first line contains field names (column names) make sure the “First record 

has field names” box is checked 

o Set the geometry definition (typically “Point Coordinates”), and identify fields for 

X and Y coordinates (e.g., Longitude and Latitude, respectively). 

o If the data are based on a geographic projection Decimal Degrees are expected; if 

data are as Degrees Minutes Seconds, check the “DMS Coordinates” box 

o Click “OK” and layer will appear in “Layers” pane. You can adjust the 

symbology by editing the properties as described above. 



EEB – OSOS Workshop  Freeware GIS 

M.L. Treglia 12 June 2014 10 



EEB – OSOS Workshop  Freeware GIS 

M.L. Treglia 12 June 2014 11 

Add a Background Layer 

*Note – at the time of writing, this plug-in is not yet available for QGIS 2.4. 

When we import spatial data, we often like to visualize them over some sort of background layer, 

such as aerial imagery, or a simple map. This allows us to identify if layers are being displayed 

in approximately the right location, and it can help with some preliminary interpretation of data. 

For this exercise, we will utilize the OpenLayers plugin. 

 Click on “Plugins” from the menu bar at top, hover your mouse over “OpenLayers 

plugin”, and a list of image servers will appear. 

o Click on the layer of your choice (lets go with the “Google Hybrid Layer” for 

now), and it will appear as the top layer on your map. 

 Adjust the layer order and symbology so you can better visualize what is going on. The 

image below (right), illustrates the scene with this background layer and the county 

boundary. 
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Open and Manipulate a Raster Layer 

 Click the “Add Raster Layer” icon  

o Navigate to the desired file; can either specify desired file type or browse any of 

the available types. Browse to the “DEM 1ArcSec” folder and select 

“imgn31w097_1.img”. 

 Change Color Palette 

o Right-click on the layer (“imgn31w097_1”) and select “Properties” 

o Click “Style” – There are lots of options to adjust. The below steps just serve as 

an example. (See next page for sample dialogue box). 

 Change “Render Type” to “Singleband pseudocolor” (Avoid multi-band 

options unless you are using multi-band imagery like Landsat data) 

 Adjust the Min/Max settings as desired. 

 Using the true “Min/Max” (second option) will have the color 

gradient span the entire range of values in the raster dataset. 

 Select a color ramp that you like (e.g., BrBG) and click “Classify” button 

to set bins automatically, and click “Apply”. If you like it, click “OK”, if 

not, adjust as needed. Feel free to try adjusting other options too. 

 You can also adjust colors and labels in the editing box to the left. 

 You can use “Save Style” and “Load Style” buttons to use a 

standard color ramp across multiple projects or raster layers. 



EEB – OSOS Workshop  Freeware GIS 

M.L. Treglia 12 June 2014 13 

 You can use the “Zoom In” tool to zoom in enough to see individual pixels. Select the 

tool from the toolbar, and click and drag a box on the area you wish to zoom to. 

 To measure an individual pixel and make sure it is the size you expect click on the 

“Measure” tool from the toolbar, and select “Measure Line” from the drop-down menu. 

o Click at one edge of the pixel, and drag the cursor to the other side; the dialogue 

box will show the measurement based on the units and datum of the Project CRS 

(see Projection Section, next). 
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Projections 

Projection of Layers and Project 

QGIS automatically reads projection information (i.e., the Coordinate Reference System [CRS]), 

if available, from respective layer files. For shapefiles, it relies on the “.prj” file; for raster data, it 

is often embedded in the file. If you load data without built-in projection information (e.g., a 

Delimited Text File), it assumes a geographic coordinate system (Lat/Long), and uses the World 

Geodetic Survey 1984 (WGS84) datum. It is always a good idea to check that the projection 

information is interpreted correctly by QGIS. 

 To check the CRS, (and set it if it was not automatically detected) right-click on layer and 

select “Set Layer CRS”. 

o If you do this for the Copperhead Data you will see the CRS that selected is 

WGS84 (using Lat/Long coordinates). This is correct – the datum of the original 

data was exactly that, so nothing needs to be changed, although if it was incorrect, 

you could fix that here. 

By default, layers with different projections are “Projected on the Fly” for visualization – they 

are automatically transformed to be in the same coordinate space (WGS84 is generally the 

default CRS for all projects). You can change that, which will make it is easy to tell if individual 

layers are set to drastically different CRS. Click the Project Menu at on the menu bar at top and 

select Project Properties (or just press CTRL+SHIFT+P). Then, uncheck the box at top for 

“Enable ‘on the fly’ CRS transformation” and click “OK”. Now you can see how the layers line 

up to each other when using their native projections – click the “Zoom Full” button on the 

toolbar at top, and the map area will zoom out to include all layers.  
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Changing Projections (CRS) 

For many operations it is necessary to have all layers in the same CRS; even if it is not 

necessary, it can help speed-up processing considerably. The DEM has elevation in meters, 

according the layer’s metadata, and it is in a geographic projection. However, for computing 

some derivatives of elevation such as Slope, it is helpful to have the horizontal units the same as 

the units for elevation. Thus, we will work in a projection that is also defined in meters, the 

Albers Equal Area Projection. This projection may cause some distortion in shape, but maintains 

accurate area measurements. This is just a demonstration, and in doing your own work, it is 

important to consider how spatial distortions may manifest in different projections.  

The steps for converting the CRS of raster and vector layers are somewhat different. 

Furthermore, when converting the CRS of raster layers, it is important to think about how 

resampling may cause distortion and inaccuracy. This will not be covered in depth here, but 

Mike Bostock provides a useful visualization of this: http://bost.ocks.org/mike/example/. 

 

Changing Project CRS 

As aforementioned, we will use the Albers Equal Area Projection, useful for dealing with the 

DEM. Other projections, such as Universal Transverse Mercator could also be used. 

 Navigate to the Project Properties dialogue box. 

o Browse for “North_America_Albers_Equal_Area_Conict” or use the Filter box to 

search for that, and select the appropriate CRS. A standard code used for this CRS 

(the EPSG code) is 102008. 

 Alternatively, right-click on a layer with the desired CRS, and select “Set Project CRS 

from Layer” [not applicable for this project]. 

http://bost.ocks.org/mike/example/
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Changing Vector CRS (for a Shapefile) 

This process involves creating a new shapefile with the desired CRS.  

 Right-click on layer that you wish to change the CRS of (in this case, select the 

Copperhead Data) and Select “Save As” 

 Set “Format” to “ESRI Shapefile” 

 Use the “Save As” box to designate an appropriate file location and name for the 

resulting shapefile. 

 For the CRS, you can use the “Project CRS” (Or use the Browse button to navigate to the 

appropriate CRS if necessary).  

o Selecting “Layer CRS” 

simply retains the original 

CRS 

 Check the box for “Add Saved 

File to Map” 

 Click “OK” (the original layer 

can then be removed from the 

map by right clicking on it and 

selecting “remove”, or by using 

the “Remove Layer” icon). 

Now do this for the remaining shapefiles. 
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Changing Raster CRS 

As with vector datasets, when reprojecting a raster, a new file is created and added to the project 

 Click on the Raster menu, mouse along to Projections, and click on “Warp (Reproject)”. 

In the Dialogue box (illustrated on the next page): 

 Designate the input file from the current project 

 Set an output file and the Source SRS (same as CRS). 

 Set the Target SRS to the desired CRS. 

 Select the desired resampling method. 

o For continuous variables, typically want to use something like bilinear or cubic 

spline that interpolates. If it is a categorical variable, nearest neighbor (“Near”) is 

generally appropriate. 

 If using a computer with a multi-core processor, check the box for “Use multithreaded 

warping implementation” 

 Check the box for “Load into canvas when finished” to bring the final product into the 

current project. 
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**Note – specific parameters for the reprojection of rasters can also be edited using the text at 

the bottom of the dialogue box, based on the arguments described here: 

http://www.gdal.org/gdalwarp.html To start editing this section, simply click the pencil icon, 

place the cursor in the box, and start typing. 

http://www.gdal.org/gdalwarp.html
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Geo-Processing of Data Layers and Associated Tables 

QGIS has a wide variety of built-in processing operations, and with the other included programs 

it has incredible capability and functionality, easily accessible via the Processing Toolbox. We 

will only cover a handful of operations here, but I suggest exploring menus, the Processing 

Toolbox, and plugins to find other operations that you need. In QGIS, these operations generally 

create a new layer rather than simply editing the original. 

 

Some Basic Vector Operations 

Clipping (Remove unwanted sections of a layer, based on outlines of other Layer) 

Hypothetically, say we are working on a project that involves streams of the city of College 

Station, but the stream layer that we downloaded was for the entire county. Thus, we will clip the 

Rivers and Streams to the County Boundary. 

 Select the Vector menu at the top and navigate to “Geoprocessing Tools” and then “Clip” 

(illustrated on the next page) 

o Input Vector Layer is the layer that you want altered (Rivers and Streams). 

o Clip Layer is the Layer that you are clipping data to (City Limits). 

o Designate the new file you want to create in the Output Shapefile box  

(“CS Rivers.shp”). 

o Check the box for “Add result to canvas” and click “OK”. 

 Upon completion, view result and delete original if it is no-longer needed. 
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“Difference” (Clip out the inner area of a polygon)” 

In another scenario, we may be interested in a geographic area, excluding a core area. With the 

data at hand, perhaps we are interested in something about County Boundary, but wish to 

exclude the area of College Station. 

 Select the Vector menu at the top and navigate to “Geoprocessing Tools” and then 

“Difference” (from the same menu shown on the previous page). 

o Input Vector Layer is the layer that you want altered (Brazos County Boundary). 

o Clip Layer is the layer subtracting from the Input Vector Layer (City Limits). 

o Designate the new file you want to create in the Output Shapefile box  

(“Brazos Cty No CS.shp”). 

o Check the box for “Add result to canvas” and click “OK”. 

 Upon completion, inspect the result and delete original if it is no-longer needed. 
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View and Edit the Attribute Table 

Many times we need to look at the attribute table for a given layer, and sometimes even make 

some edits. 

 To view the attribute table, simply right click on the desired layer and select “Open 

Attribute Table”. Let’s start with the attribute table for the Rivers and Streams layer. 

There’s lots of information here that came with the layer. Some things that might be of interest 

for researchers include the Name and the HydroType (what type of stream/river each element is). 

 

If you want to look at a single data entry simply select that row by clicking on the number to the 

left of the data, and it will become highlighted on the map. For the stream segments, they’re 

small, so you’ll need to zoom in to see it. While looking at the map, select the Rivers and 

Streams layer by clicking on it in the Layers pane, and then use the “Zoom to Selection” icon to 

focus on the selected stream segment. To zoom out to the entire map again, use the “Zoom Full” 

icon, or click the “Zoom Out” icon and click on the map.  

 

To edit the table, you must first enable editing by clicking the “Toggle Editing Mode” icon in the 

toolbar above the table. Then you can edit text, and add/delete rows or columns using the icons 

at the top of the window. You can also do some table manipulations by altering the layer 

properties. You cannot, however, alter existing column names or data types from this menu. To 

do that, it is best to use the Table Manager plugin. If it is installed, click the icon, typically 

located on the left, along the “Layers” pane.  
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Spatial Join 

We can use the spatial relationships among objects in our project to join tables with different 

information. 

 

Let’s add the name of the county that streams are located in as a field for the Rivers and Streams 

layer. We will use the Rivers and Streams and the County Boundary layers in this example. 

 We need to make sure the attribute table for County Boundary has a field with the county 

name, preferably with a field name that is unique among both layers. 

o Open the attribute table for County Boundary; there is a field with the county 

name (“Name”). We could use this column as-is for the join, but Rivers and 

Streams already has a column called “Name”. To avoid confusion, we will re-

name the column 

 Close the attribute table, make sure County Boundary is selected in the 

Layers pane, and open the Table Manager. 

 Highlight the field “Name”, click the “Rename” button, and change the 

name to something logical (e.g., CountyName). Click the “Save” button, 

and close the window. 
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With the attribute tables set up appropriately, we can do the now do the join. 

Use the Vector menu to access “Data Management Tools”, and then click “Join attributes by 

location”. (Dialogue box on the next page). 

 The “Target Vector Layer” will be  the layer we wish to add information to (Rivers and 

Streams) 

 The “Join Vector Layer” will be the layer we wish to add information from (Brazos 

County Boundary) 

 For this example, use the default options for “Attribute Summary” and “Output Table”, 

and set a the information for the resulting shapefile. 

 Click “OK” and select “Yes” when a window pops up asking if you want to add the new 

layer to the project. 

 If you open the attribute table for the new stream layer, you will see all of the information 

from County Boundary associated with the streams. 
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Add Geometry Information to Attribute Tables 

Vector datasets will sometimes come with geometry information about the layer in the attribute 

tables (e.g., length of lines, or perimeter and area of polygons). This is useful, although if you 

transform the data to a different projection, the geometry may no longer be accuate because the 

alternative projection is a somewhat different representation of Earth’s surface. Other times, 

individual layers do not contain any geometry information that might be desirable. 

 

Most of the vector layers we are using already have geometry data. For this exercise, we will 

first remove the geometry column for the Rivers and Streams layer and then use QGIS to add 

geometry information back in. 

 Click on the Rivers and Streams layer in the “Layers” pane to select it. 

 Open the Table Manager. 

o Select the “Length” field and click the “Delete” button to delete it. 
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 Click “Save” and close the window. 

 If you want, open the Attribute Table for the layer to confirm the field was deleted. Close 

it before the next step. 

 Use the Vector menu to navigate to “Geometry Tools” and “Export/Add geometry 

columns. 

  

 Select the Rivers and Streams layer, use “Calculate using” = “Layer CRS” (for the 

current projection of the layer) and click “OK”. 

o After the processing bar completes, close the window. 

 Open the attribute table for Rivers and Streams and you should now see a new column, 

“LENGTH”. 
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Some Basic Raster Operations 

Both stand-alone and with plugins, QGIS has a diverse toolkit for working with raster datasets. 

As with the vector operations, only a handful are covered here, but I encourage you to browse 

through the menus, plug-ins, and documentation to find other operations you may need. Note 

that there are also various image processing tools that are useful for remote sensing work. 

 

Calculate Slope from a DEM 

 Use the Raster menu to navigate to “Analysis” and then “DEM (Terrain models)” 

 In the Dialogue box, select the Input File (DEM Albers), and designate an output file 

(note: you will have to designate a file type; here I use ERDAS Imagine format (.img), 

but you can use others as well; be sure to include the file extension in the file name). 

 Set the “Mode” to “Slope”. There are a number of other processing options you can 

choose if you wish. 

 Change any of the “Mode Options” if you wish, though I will just use the default settings; 

make sure the “Load into canvas when finished” box is checked. 

 Click “OK”. 
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*Note – As with the reprojection of rasters, the terrain model options can also be adjusted with 

the set of commands at the bottom following the arguments listed here: 

http://www.gdal.org/gdaldem.html. To enable editing, click the pencil icon, illustrated to the left. 

http://www.gdal.org/gdaldem.html
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Reclassify Raster 

Many times we need to reclassify values from a raster dataset. In this example, we will change 

continuous data into categorical groups; this may be appropriate if we know specific tolerances 

of a species, and have a relevant raster layer. I find the easiest ways to reclassify a dataset are 

using either the GRASS or SAGA GIS utilities, accessed through the Processing Toolbox. Here, 

we’ll use SAGA GIS (www.saga-gis.org/). 

 Open the Processing Toolbox - click the Processing menu, on the menu bar at top, and 

select “Toolbox”. 

 

 You should now see the “Processing Toolbox” (above, left). Make sure the option at the 

bottom is set to “Advanced Interface”, not “Simplified Interface”. This toolbox allows 

you to access algorithms and functions from a variety of other programs that were 

installed with QGIS including GRASS and SAGA.  

We will reclassify values of the DEM (elevation) to indicate that pixels are suitable for a 

hypothetical species (>75 m; set to 1), or not suitable (≤ 75 m; set to 0). 

http://www.saga-gis.org/
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Expand the list under SAGA by clicking on the “+” next to it, then expand the list under “Grid - 

Tools”, and double-click on “Reclassify grid values”. 

 Select the DEM Albers layer as the Grid layer, and change the “Method” to “[2] simple 

table” 

 Scroll down to “Lookup Table” and click on the “…” icon.  

 Fill in the table as indicated below, then put your cursor in the third column and click 

“Remove row”, and then “OK”. The lowest and highest values (0 and 150) are based on 

the maximum and minimum of the entire DEM, which can be viewed by clicking the “+” 

next to the layer in the “Layers” pane. 

 Leave the “operator (for table)” option set to the default 

 Make sure the box is checked for “Open output file after running algorithm” 

 Set the “Reclassified Grid” to a file of your choice (for this, geoTIFF [.tif] seems to work 

well; .img does not for some reason, as it has multiple bands in the output). 

 Click “Run”; you will see a new layer “Reclassified Grid” in the “Layers Pane” – right 

click on it and select “Rename” to rename it appropriately (e.g., DEM Reclass) 

*Note, there are a variety of options here; those used here accomplish the task at hand; I 

encourage you to explore SAGA GIS, and explore what other options do in your free time. 
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We will now do the same thing for the Slope raster using, following the values in the lookup 

table below. (Low slope, 0-2° are suitable for the hypothetical species; high slopes, >2°, are not). 

Rename this new layer appropriately (e.g., Slope Reclass) 

 

To verify that these reclassified layers are correct, you can bring the respective reclassified layer 

to the top, and use the “Identify Features” tool to inspect the values of each raster. Click on the 

icon in the toolbar, and a new pane should appear (typically on the lower left, “Identify 

Results”). Then click the mouse on a point, and it will by default show you the properties (e.g., 

value or fields) of the layer highlighted in the “Layers” pane. You can adjust the “Mode” and 

“View” options in the pane, to view characteristics of multiple layers at once. 
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Raster Calculator 

Many times we need create a new raster layer that is based on a composite of other layers. For 

example, in the previous examples we reclassified DEM Albers and Slope Albers rasters to 

identify where elevation and slope are suitable for a hypothetical species. We can combine these 

reclassified layers, mathematically, to identify where BOTH elevation and slope are suitable, 

simply by multiplying overlapping pixels from the respective layers. In this resulting raster, areas 

where a pixel is 0 in either raster will be 0 (unsuitable based on both layers); locations where 

both characteristics are suitable will be represented by values of 1. 

 Use the Raster menu on the menu bar and navigate to 

“Raster Calculator”. 

 In the dialogue box that pops up, double-click either the 

DEM Reclass or the Slope Reclass layer to add it to the 

expression box in the bottom. (See next page for an example 

dialogue box.) 

 Click the “*” button to designate the multiply function. 

 Add the other relevant layer to the expression box 

 Designate an output location, set the format, check “Add result to project”, and click 

“OK”. 

After processing, you will see the new layer in the “Layers” pane, and you can explore it to 

ensure the output is as-expected. 
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You can use this tool for various other calculations, using the buttons provided. You can also 

type in the “Raster calculator expression” box at the bottom, to add numeric terms and such. 
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Using Vector and Raster Datasets Together 

Clipping a Raster 

When downloading raster layers, they are frequently available for larger areas than necessary, 

which can contribute to additional processing time and decrease available memory. To deal with 

this, we can easily clip the raster to the bounds of a vector dataset or to a set of boundaries based 

on coordinates. 

 Click on the Raster menu from the menu bar, navigate to “Extraction” and click on 

“Clipper” to open the relevant dialogue box (shown on the next page). 

 Designate a raster as the input file (I will use “SlopeDEM_Reclass”, the result of the 

previous raster calculation, or the habitat suitability map for a hypothetical species). 

 Check the box for “No data value” and set it to something not in your current raster layer. 

We’ll use -9999, which is commonly used for this purpose. 

 For “Clipping Mode”, click in the circle for “Mask layer” and select a vector layer that 

you want to use for the boundaries of the new raster layer. We’ll use the City Limits in 

this exercise. If you wish, you can also use the “Extent” option and designate the 

appropriate bounding coordinates. 

 Make sure the box is checked for “Load into canvas when finished” and click “OK” 

The new layer will appear in the Layers pane and you can inspect as needed.  
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* This operation is effectively done using the same basic commands as for reprojection of 

rasters, and similarly, the parameters can be edited in the text box at the bottom based on the 

“gdalwarp” function. 

** To fit the raster in the appropriate space as designated by the vector layer, it actually 

resamples the raster data and moves it slightly to fit. You can use the arguments in the gdalwarp 

command to select the desired resampling type. 
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Compute Zonal Statistics for Polygons 

It is often useful to calculate metrics from a raster layer for a vector dataset, for example the 

mean elevation or slope of a polygon. The “Zonal Statistics” plugin is great for this, and there are 

other tools (e.g., in SAGA GIS) that allow additional flexibility. 

Using the Zonal Statistics plugin: 

 Use the Raster menu from the menu bar to navigate to and click on “Zonal statistics” 

 For “Raster layer”, select the raster that you want to compute statistics from; for the 

“Polygon layer containing the zones”, select the appropriate vector layer. We’ll use the 

DEM and the County Boundary layers, respectively 

 Designate an prefix for the resulting columns (to help remember which raster you used) 

and click “OK” 

 

You can view the result by opening the attribute table for the polygon layer; and you will see 

new columns representing the “count” (count of all contained pixels”, the “sum” (sum of all 

values for the contained pixels), and the “mean” (average of all values for the contained pixels). 
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Using SAGA GIS: 

 In the “Processing Toolbox” expand the menu for “SAGA”, then expand “Shapes – Grid” 

and double-click on “Grid statistics for polygons”. Note there are a number of other 

useful options, like adding grid values to points or other shapes. 

 In the dialogue box (next page), under “Grids” click the “…” button to and select the 

desired raster (we’ll use the DEM again). 

 Under “Polygons” select the vector layer you wish to calculate the raster statistics for. 

Again, we’ll use the County Boundary. 

 Select whichever statistics you wish to calculate. Note there are a number of options. 

We’ll use “Mean” and “Variance” (for the others, change the box below the titles to 

“No”. 

o You can designate quartiles you wish to calculate; if you want the Median, 

calculate the 50
th

 quantile. 

 In the “Statistics” box, you can let it save the output to a temporary file, which will add 

new columns to the existing table and create a new layer for it called “Statistics”. 

 Check the box for “Open output file after running algorithm” and click “Run” 

 You can then view the results in the attribute table. In QGIS the columns are not named 

with the statistic, but with an abbreviation of the raster and a sequential number; you can 

use the table manager to rename these appropriately.” 
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Making a Quality Map Layout 

QGIS works well for making maps, with easily customizable symbology, and a good set of tools 

to develop a layout for print and publication. Here, we will make a basic map of the habitat 

suitability raster for the city of College Station, with an inset showing where College Station is in 

Brazos County. We will include standard map elements including a scale bar, north arrow, 

legend, and coordinate grid. I encourage you to explore other options and setups for this after the 

workshop, or try making one with your own data. As with the other features of QGIS, I only 

have time to highlight a relatively small subset of map-making tools. 

 To get started, open the print composer by clicking on icon indicated at left. If you were 

to have an existing layout that you wish to access in the project, click on the icon to the 

right, “Composer Manager”. After clicking the icon to create a new layout, you can either 

designate a new name or allow the program to generate one for you. 

 

Setting up for a Map 

Maps that you bring into the layout will be based on what you see in the main QGIS window. 

Let’s go back to that for now and start by visualizing the layers of the City Limits, Habitat 

Suitability, and Rivers of College Station (from the vector clipping exercise).You can order them 

as you wish, but make sure you can see all elements (for the City Limits layer, you can have that 

on top as long as you adjust the transparency or fill so you can see the other layers, and make 

sure the city boundary is obvious). Manipulate the symbology and labels for these layers to your 

liking, so they will appear alright in a map together. See my set-up on the next page. The orange 

color represents areas suitable for the hypothetical species, purple represents unsuitable, and the 

blue lines are the rivers and streams. 
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Think about what types of coordinate you want to show on the borders of the map; they have to 

be the same as used in the Project CRS. Many people like to see the geographic coordinates, so I 

change mine to WGS84 for display purposes, and use projection on-the-fly. You may want to be 

explicit in a caption about what projection you used to conduct any analyses. After setting that, 

make sure to click the “Zoom Full” button to make sure the focal area takes up as much of the 

viewing area as possible. (You can also adjust the viewing scale using the “Scale” adjustment at 

the bottom of the main QGIS screen.)  
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Once satisfied with the layout of the main map, we are ready to start putting a final layout 

together. 

 Go back to the Composition window. 

 In the pane that is on the left, adjust the layout settings through the “Composition” tab. 

 The only thing we’ll change for now is the Paper Size – change to “ANSI A (Letter; 

8.5x11 in). 
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Putting Everything Together 

Adding the Map of interest to the Layout 

 In the Composition window click the “Add Map” icon, and click and drag a box for in the 

area you would like the main map to occupy. The view from the main QGIS window 

should now appear in that area. 

o You can go to the “Item Properties” tab to adjust the extent and such. I simply 

click the button “Set to Map Canvas Extent” to show the same extent as in the 

main QGIS window. 

 By default, the map layout is cached in memory; if you adjust anything in 

the main map, click the “Update Preview” button to show the updated 

version.  

 Check the box for “Lock layers for map item”; if you don’t, when you 

create an inset, this map will be altered. 

 

Adding Gridlines and Coordinates 

 In the “Item Properties” tab, check the box and expand the section for “Show grid”. The 

settings I use are shown in context on the next page and the general appearance is 

illustrated below. 

 The units will be the same as used in the Project CRS. Adjust the spacing and offset in 

the “Interval” and “Offset” boxes. This usually takes some trial ane error to make it 

aesthetically pleasing. 

 Expand the “Grid frame” section and change “Frame style” to “Zebra”. 
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 Expand the “Draw coordinates” section and check the respective box. Adjust settings as 

you see fit; the only adjustment I illustrate is changing the precision of coordinates 

shown. 
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Adding Scale Bar, North Arrow, and Legend 

 For the Scale Bar: click the “Add Scale Bar” icon, and click and drag a box where you 

want the scale bar to be placed. 

o The scale bar will appear in that area with some default settings. You can adjust 

things like the units and appearance in the “Item Properties’ tab, which now 

characterizes the scale bar. 

*Note: the “Item Properties” tab is dynamic, changing with the type of object you have selected. 

 For the North Arrow: click the “Add Image” icon, and click and drag a box where you 

want the north arrow placed. 

o In the “Item Properties” tab, expand the section for “Search Directories”. The 

default path links to a directory that has available images included with QGIS. 

You will see a few that work as a north arrow; select one and click the “Add” 

button. You can rotate it if necessary, to match rotation of the map if it is not the 

typical north-to-the-top orientation. 
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 For the Legend: Click the “Add new legend” icon, and click and drag a box where you 

want it to be placed. A default legend will appear in that area; the box will automatically 

resize to accommodate the dimensions. 

o Again, use the “Item Properties” tab to adjust the settings. Most obviously, we 

want to change some of the labels in the legend so they are not simply the layer 

names from our QGIS project. Note that you cannot change the symbology here – 

you must do that in the main QGIS project window. 

 Expand the “Legend items” section. You can add a new layer to the 

legend, re-arrange the order, and rename items. To change the name of an 

entry, click on the legend entry you wish to edit, and click the “Edit” icon 

and type a new name that you prefer. In the example shown below, the 

City Limits entry is being renamed to “College Station Boundary”. For 

editing specific entries for grouped legend items (e.g., the legend for 

Habitat Suitability layer), expand the group by clicking the “+” icon next 

the highest level item, and select the specific item you wish to edit before 

clicking the “Edit” icon. 

 You can add and edit a box around the 

legend by clicking the box for, and 

expanding the “Frame” section. 
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Adding an Inset 

Now, the map is starting to really look like a map, but one thing that is useful to have is an inset 

that shows where things are in the broader context. To create this, we need to again set up our 

layers as we wish them to appear in the inset. The only layers we really need here are the County 

Boundary and the City Limits. It is best to use a copy of the City Limits layer, as it is used on the 

main map, and editing the original will alter the final product when we export it. To duplicate a 

layer, in the “Layers” pane of the main QGIS window, select the layer you want a copy of, right 

click, and click “Duplicate”. 

 Do as described earlier to create a suitable looking map with the Brazos County 

Boundary and City Limits layers in the main QGIS window. Below is an example setup.  

 In the Composition window, click the “Add new map” icon again, and draw a box where 

you want it to appear. You can edit it, as with the main map, using the “Item Properties” 

tab. Perhaps add a frame to it, to make it stand out and delineate it as a separate entity 

from the rest of the map. You can also add gridlines and coodinates as desired. 

 Again, check the box for “Lock layers formap item”. 
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 You can add a label to this using the “Add new label” icon; select it and click and drag a 

box where you would like the text. 

o In the “Item Properties” tab you can edit the text, font characteristics, and text box 

characteristics. 

Final Formatting and Exporting the Map 

We are almost done creating a final, high quality map. Now you can add anything else you need. 

On the next page, you can see my final version; the only other element I have added is another 

label to serve as a title for the map. If you need to move anything around, make sure the 

“select/move” icon is selected, click on the focal element, and move or re-size it. You can also 

add shapes and arrows using the “Add ellipse” and “Add arrow” icons. 

 

Exporting the Map 

From the Composition window you can export the final product to various image formats, to an 

SVG file, or to a PDF file. Simply click on the respective icons from the toolbar at top (shown 

below, in order), designate a file name and location, and click “OK”. 
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Closing Comments 

My goal in his workshop and tutorial was to give new users a working knowledge of 

QGIS. Although we only had time for a handful of operations, I hope that you now have 

sufficient familiarity with QGIS to explore on your own, and find other functions that you may 

need for your work. If you continue expanding your use of QGIS, you may wish to script your 

work for better reproducibility and documentation. Python is a common language used for 

scripting in QGIS, and you can find more details on the web (e.g., 

http://docs.qgis.org/testing/en/docs/pyqgis_developer_cookbook/intro.html).  

QGIS is constantly being further developed, and I suggest users periodically check for 

updates to the software, as new tools are often implemented, and processing and data 

management protocols are often improved. Since I first started using QGIS, the software has 

become much more user-friendly, tools have become much more expansive, and bugs have been 

fixed. Keep up with it, and I think you’ll find it to be a suitable alternative, that is even superior 

in some ways, to expensive, paid GIS software. 

Thank you for your attention. Feel free to contact me with further questions. 

http://docs.qgis.org/testing/en/docs/pyqgis_developer_cookbook/intro.html
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